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Sigma-7 Series SERVOPACKSs

Unpacking and Mounting the Advanced Safety Module

Attaching the 1/0 Connector (SGD7S-OSB02A only)

1 Unpacking and Mounting the Advanced Safety Module

1.1 Contents of the Box

Depending on the type you have ordered, you will receive the SGD7S-OSB01A or the
SGD7S-OSB02A.The SGD7S-OSBO01A is represented by a single board, while the
SGD7S-OSB02A consists of a double board (sandwich).

Never try to disassemble. Otherwise the warranty will be lost.

The box also includes:

the Instruction Manual

the Declaration of Conformity (DoC)

the nameplate sticker, the model designation sticker and the LED identification sticker
the mounting screws

1.2 Required Accessory for Board Mounting

To attach the module to the SERVOPACK you will need the mounting rail for option cards
for Sigma-7 400 V SERVOPACKS (order no. JZSP-P7R2-8-E).

For the SGD7S-OSB02A you additionally need the 1/0 connector (order no.
JUSP-7CN21).

1.3 Attaching the Advanced Safety Module to the SERVOPACK

1.

© @ N | |

1.

Read the Instruction Manual to find out how to attach the module to the SERVO-
PACK.

Also pay attention to the safety instructions in this manual.

Make sure that the power supply (main power supply 400 V AC and control power
supply 24 V DC) is switched off and the charge LED of the SERVOPACK is not lit.

Then start by opening the cover for the Option Modules on the right-hand side of
the SERVOPACK.

Attach the mounting rail.

Carefully plug the Advanced Safety Module into the SERVOPACK.
Fix the module with the mounting screws.

Take the plastic module cover out of the box.

Depending on your needs, you should break out the openings in the cover for the
CN21 connector (SGD7S-OSB02A) and/or for other interface connectors for addi-
tional option modules as the second encoder module.

Attach the nameplate sticker, the model designation sticker and the LED identifica-
tion sticker on the designated fields on the cover. For a detailed illustration of the
specified positions, see chapter 3.3 of the Instruction Manual.

Close the cover.

1.4 Attaching the I/0 Connector (SGD7S-OSB02A only)

1.
2

Read the Instruction Manual and make sure that the power is switched off.

Plug the field connector JUSP-7CN21 into the CN21 plug of the Advanced Safety
Module.
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Unpacking and Mounting the Advanced Safety Module Sigma-7 Series SERVOPACKSs

FSoE Connection

3. » Close the both levers of the connector to tighten the connection. This prevents the
connection from being loosened by vibrations or shocks.

() Do not mix up the I/O connection of the SERVOPACK with the I/O
i connection of the Advanced Safety Module. This could damage the
safety module or the SERVOPACK.

[l |

4. ), Follow the instructions in the Product Manual for I/O wiring. Analogue signals must
be shielded. An external 24V SELV/PELV power supply must be connected to drive
the digital outputs.

1.5 FSoE Connection

Plug the Ethernet cable (CATS or higher such as Yaskawa Part Numbers found below) of
the previous FSoE communication device into connector CN6A (input) and the next FSoE
device into connector CN6B (output) of the SERVOPACK. However, the FSoE master
can also be located anywhere within the network.

Cables with RJ45 Connectors on Both Ends

Cable Length Item Number

0.2m CM3RRMO0-00P2-E
0.5m CM3RRMO0-00P5-E
1m JZSP-CM3RRM0-01-E
3m JZSP-CM3RRM0-03-E
5m JZSP-CM3RRMO0-05-E
10 m JZSP-CM3RRMO0-10-E
20m JZSP-CM3RR00-20-E
30m JZSP-CM3RR00-30-E
40 m JZSP-CM3RR01-40-E
50 m JZSP-CM3RR01-50-E
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Sigma-7 Series SERVOPACKSs Switching On the SERVOPACK

Switching On the Control Voltage > Preparations

2  Switching On the SERVOPACK
2.1 Switching On the Control Voltage

2.1.1 Preparations

The correct assembly and wiring of the SERVOPACK and the Advanced Safety Module is
described in the Instruction Manual and the Product Manual.

Observe the safety regulations for the protection of people and equipment.

You need the Advanced Safety Module Parameter Editor tool on your PC (laptop) to con-
figure the Advanced Safety Module.

1. ) Please download the tool software from the Yaskawa homepage yaskawa.eu.com.

2. , Follow the instructions in the Quick Installation Guide to install and activate the tool.
(You can also find the Quick Installation Guide as a download on the homepage in
the Safety Option Module section).

3. » If you have installed the Advanced Safety Module Parameter Editor on your PC
(laptop), connect the USB online cable JZSP-CVS06-02-E to your USB interface
and plug it into the CN7 connector of the SERVOPACK.

4. ), Start the tool on your PC.

) For more detailed information on the Advanced Safety Module
i Parameter Editor, see & Chap. 3 ‘Creating a Project using the
Advanced Safety Module Parameter Editor’ page 22.

[l |

5. ) Please note the serial number of the Advanced Safety Module. It will be needed in
the next step of the initial start-up.
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Switching On the SERVOPACK

Sigma-7 Series SERVOPACKSs

Switching On the Control Voltage > Initial Start-Up

2.1.2 |Initial Start-Up
1.

Switch on the control voltage of the SERVOPACK.

O After the voltage has been switched on, the pairing of the safety
i module and the SERVOPACK is carried out automatically.

[l |

= B The SERVOPACK stores that the safety module is connected.
B The safety module stores the serial number of the connected SERVOPACK.

Sigma-7 | DQ138H848410020
Serial No.
Safe
container
N
: :
Sigma-7 400V ; Advanced
SERVOPACK | Safety Module

Fig. 1: Pairing of Safety Module and SERVOPACK

2,

Observe the devices.

The red LED on the Advanced Safety Module lights up. The error display on the
SERVOPACK shows "A.EC1" (Safety-related Servo Parameter Unmatch Alarm) or
"A.ECO" (Safety Module Confirmation Alarm).

Alarm cause "A.EC1": There is no valid safe container in the safety module.

Alarm cause "A.EC0": Serial number of the SERVOPACK and serial number of the
SERVOPACK stored in the safety module do not match.

If the error "A.EC0" (Safety Module Confirmation Alarm) appears on the SERVO-
PACK error display, continue with step 2 in chapter & Chap. 2.1.3.2 ‘Safety Module
already in operation and new SERVOPACK’ page 17.

Continue with the parameterisation via the Advanced Safety Module Parameter
Editor.

The parameterisation is described in detail with an example in chapter % Chap. 3
‘Creating a Project using the Advanced Safety Module Parameter Editor’ page 22.
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Sigma-7 Series SERVOPACKSs Switching On the SERVOPACK

Switching On the Control Voltage > Initial Start-Up

4. , During parameterisation, you must enter the serial number of the Advanced Safety
Module when configuring the General Device Parameters. Without this entry, it is
not possible to generate a safe parameter container upon completion of the project
file.

The Advanced Safety Module Serial Number consists of a total of 15 digits (2 char-
acters and 13 numbers), e.g. D0207A000110004. Locate the serial number of the
Advanced Safety Module to be deployed and enter it exactly in the applicable data
entry field.

Fig. 2: The General Device Parameters dialog

5. ) Enter your safety parameters as described in chapter & Chap. 3 ‘Creating a Project
using the Advanced Safety Module Parameter Editor’ page 22.
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Switching On the SERVOPACK

Sigma-7 Series SERVOPACKs

Switching On the Control Voltage > Initial Start-Up

6. . When all the necessary intermediate steps described in chapter & Chap. 3 ‘Cre-

ating a Project using the Advanced Safety Module Parameter Editor’ page 22 have
been carried out, click on CMIF Container Transfer in the Device menu.

Fig. 3: Safe Container File loaded

10
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Sigma-7 Series SERVOPACKSs Switching On the SERVOPACK

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

7. Click on the Send File button to start the download of the safe container file to the
Advanced Safety Module.

= When the download is completed successfully, a Write Success message will
be displayed.

Fig. 4: Safe Container File Sending Completed

As a result, the alarm "A.EB9" may occur to indicate a change of the ASM7
parameter set. This change must be activated by a power cycle to enable the
new setting (a software reset with SigmaWin+ can also clear the "A.EB9"
alarm).

8. » Restart the SERVOPACK.

= The error display on the SERVOPACK shows "HWBB" for 5 seconds. After that,
the display goes out and no more errors are displayed. The green LED on the
Advanced Safety Module lights up.

2.1.3 Start-Up for other SERVOPACK / Safety Module Constellations

When combining a SERVOPACK or Advanced Safety Module that has been previously
used in safety applications, the behaviour differs from the initial start-up.

2.1.3.1 SERVOPACK already in operation and new Safety Module

Use of the identical Safety In this case, the start-up procedure is identical to the procedure described in chapter
Module type & Chap. 2.1.2 ‘Initial Start-Up’ page 8.
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Switching On the SERVOPACK Sigma-7 Series SERVOPACKSs

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

Use of a different Safety
Module type

1. » Switch on the control voltage of the SERVOPACK.
= The safety module stores the serial number of the connected SERVOPACK.

_ _\

Sigma-7 | DQ138H848410020
Serial No.

Safe
container

N

3
Sigma-7 400V
SERVOPACK

Advanced
Safety Module

Fig. 5: Pairing of Safety Module and SERVOPACK
2. ), Observe the devices.

The red LED on the Advanced Safety Module lights up. The error display on the
SERVOPACK shows "A.E81" (Safety Option Module Unmatch Alarm).

Alarm cause: A safety module of a different type was connected.
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Sigma-7 Series SERVOPACKSs Switching On the SERVOPACK

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

3. ) Execute Fn014 (Reset Option Module Configuration Error) with SigmaWin+ or the
Digital operator.

With the help of this step, the SERVOPACK deletes that a safety module was con-
nected.

Fig. 6: Reset Option Module Configuration Error

=

) Please note that the USB port can only be used by one tool at a
i time. In this case, you should first close the Advanced Safety
Module Parameter Editor before opening SigmaWin+.

Switch off the control voltage of the SERVOPACK.
5. » Switch on the control voltage of the SERVOPACK.
= The SERVOPACK stores that the safety module is connected.

6. 5 The Safety-related Servo Parameter Unmatch Alarm (A.EC1) is displayed.
Alarm cause: There is no valid safe container in the safety module.

7. » Continue with the parameterisation via the Advanced Safety Module Parameter
Editor.

Please note that the USB port can only be used by one tool at a
i time. In this case, you should first close SigmaWin+ before opening
the Advanced Safety Module Parameter Editor.

The parameterisation is described in detail with an example in chapter & Chap. 3
‘Creating a Project using the Advanced Safety Module Parameter Editor’ page 22.
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Switching On the SERVOPACK Sigma-7 Series SERVOPACKSs

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

8. » During parameterisation, you must enter the serial number of the Advanced Safety
Module when configuring the General Device Parameters. Without this entry, it is
not possible to generate a safe parameter container upon completion of the project
file.

The Advanced Safety Module Serial Number consists of a total of 15 digits (2 char-
acters and 13 numbers), e.g. D0207A000110004. Locate the serial number of the
Advanced Safety Module to be deployed and enter it exactly in the applicable data
entry field.

Fig. 7: The General Device Parameters dialog

9. ). Enter your safety parameters as described in chapter & Chap. 3 ‘Creating a Project
using the Advanced Safety Module Parameter Editor’ page 22.
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Sigma-7 Series SERVOPACKSs Switching On the SERVOPACK

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

10.,. When all the necessary intermediate steps described in chapter & Chap. 3 ‘Cre-
ating a Project using the Advanced Safety Module Parameter Editor’ page 22 have
been carried out, click on CMIF Container Transfer in the Device menu.

Fig. 8: Safe Container File loaded
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Switching On the SERVOPACK Sigma-7 Series SERVOPACKSs

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

11.). Click on the Send File button to start the download of the safe container file to the
Advanced Safety Module.

= When the download is completed successfully, a Write Success message will
be displayed.

Fig. 9: Safe Container File Sending Completed

As a result, the alarm "A.EB9" may occur to indicate a change of the ASM7
parameter set. This change must be activated by a power cycle to enable the

new setting (a software reset with SigmaWin+ can also clear the "A.EB9"
alarm).

12.) Restart the SERVOPACK.

= The error display on the SERVOPACK shows "HWBB" for 5 seconds. After that,

the display goes out and no more errors are displayed. The green LED on the
Advanced Safety Module lights up.

16
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Sigma-7 Series SERVOPACKSs Switching On the SERVOPACK

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

21.3.2 Safety Module already in operation and new SERVOPACK
1. » Switch on the control voltage of the SERVOPACK.
= The SERVOPACK stores that the safety module is connected.

- _\

Sigma-7 | DQ138H848410020
Serial No.

Safe
container

N

3
Sigma-7 400V
SERVOPACK

Advanced
Safety Module

Fig. 10: Pairing of Safety Module and SERVOPACK
2. ), Observe the devices.

The red LED on the Advanced Safety Module lights up. The error display on the
SERVOPACK shows "A.EC0O" (Safety Module Confirmation Alarm).

Alarm cause: Serial number of the SERVOPACK and serial number of the SERVO-
PACK stored in the safety module do not match.
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Switching On the SERVOPACK

Sigma-7 Series SERVOPACKSs

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

3.

With the Advanced Safety Module Parameter Editor: Click on button "ASM7 Initi-
alize".

= This function deletes the serial number of the SERVOPACK, the homing infor-
mation and the safe container in the non-volatile memory of the safety module.

The serial number specified in the New Serial Number field
i must be the serial number of the currently connected Advanced
Safety Module.

Fig. 11: ASM7 Initialize Button

4,

Alternative possibility with the Digital Operator (replaces step 3): Execute Fn040
(Safety Option Module Access Mode Setting).

To activate this function, the last four characters of the serial number of the safety
module (attached to the SERVOPACK) must be entered (range = 0001 to 9999).

= This function enables the execution of Fn043.

Execute Fn043 (Safety Option Module Initializing Parameter Setting) with the Digital
Operator.

= This function deletes the serial number of the SERVOPACK, the homing infor-
mation and the safe container in the non-volatile memory of the safety module.

Switch off the control voltage of the SERVOPACK.
Switch on the control voltage of the SERVOPACK.
= The safety module stores the serial number of the connected SERVOPACK.

18
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Sigma-7 Series SERVOPACKs

Switching On the SERVOPACK

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

8.

10.

The Safety-related Servo Parameter Unmatch Alarm (A.EC1) is displayed.
Alarm cause: There is no valid safe container in the safety module.

Continue with the parameterisation via the Advanced Safety Module Parameter
Editor.

Please note that the USB port can only be used by one tool at a
i time. In this case, you should first close SigmaWin+ before opening
the Advanced Safety Module Parameter Editor.

The parameterisation is described in detail with an example in chapter & Chap. 3
‘Creating a Project using the Advanced Safety Module Parameter Editor’ page 22.

During parameterisation, you must enter the serial number of the Advanced Safety
Module when configuring the General Device Parameters. Without this entry, it is
not possible to generate a safe parameter container upon completion of the project
file.

The Advanced Safety Module Serial Number consists of a total of 15 digits (2 char-
acters and 13 numbers), e.g. D0207A000110004. Locate the serial number of the
Advanced Safety Module to be deployed and enter it exactly in the applicable data
entry field.

Fig. 12: The General Device Parameters dialog

1.

Enter your safety parameters as described in chapter & Chap. 3 ‘Creating a Project
using the Advanced Safety Module Parameter Editor’ page 22.
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Switching On the SERVOPACK Sigma-7 Series SERVOPACKSs

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

12.,, When all the necessary intermediate steps described in chapter & Chap. 3 ‘Cre-
ating a Project using the Advanced Safety Module Parameter Editor’ page 22 have
been carried out, click on CMIF Container Transfer in the Device menu.

Fig. 13: Safe Container File loaded
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Sigma-7 Series SERVOPACKSs Switching On the SERVOPACK

Switching On the Control Voltage > Start-Up for other SERVOPACK / Safety Module Constellations

13.). Click on the Send File button to start the download of the safe container file to the
Advanced Safety Module.

= When the download is completed successfully, a Write Success message will
be displayed.

Fig. 14: Safe Container File Sending Completed

As a result, the alarm "A.EB9" may occur to indicate a change of the ASM7
parameter set. This change must be activated by a power cycle to enable the

new setting (a software reset with SigmaWin+ can also clear the "A.EB9"
alarm).

14., Restart the SERVOPACK.

= The error display on the SERVOPACK shows "HWBB" for 5 seconds. After that,

the display goes out and no more errors are displayed. The green LED on the
Advanced Safety Module lights up.
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Creating a Project using the Advanced Safety Module Parameter Editor Sigma-7 Series SERVOPACKSs

Creating a New Advanced Safety Module Project File

3

3.1

Creating a Project using the Advanced Safety Module Parameter

Editor

Introduction

The software tool Advanced Safety Module Parameter Editor (henceforth ASM Parameter
Editor) is used to create and modify project files (with file extension *.asm7). In addition,
the ASM Parameter Editor is used to create safe parameter containers (with file exten-
sion *.bin) which can then be downloaded to the Advanced Safety Module (ASM).

3.2 System Requirements

3.3

Installation

A PC with the Windows 10 operating system is required. In order to download and upload
safe parameter containers, the installation of SigmaWin+ Version 7.40 or greater is also
required. In addition, the following Visual C++ Redistributable Package is required (if not
already installed) for the correct operation of SigmaWin+:

B Microsoft Visual C++ 2015-2019 Redistributable (x86)

The user is advised to check whether this entry appears in the list of Programs and Fea-
tures (Control Panel — Programs and Features). If the above entry does not appear in
the list of Programs and Features, download the file vc_redist.x86.exe from the following
Microsoft website:

B https://www.microsoft.com/en-us/download/details.aspx?id=48145

The installation files for the ASM Parameter Editor can be downloaded from Yaskawa’s
homepage. In order to download the installation files, the user must first register himself/
herself at Yaskawa. Upon successful registration, the user will receive an e-mail con-
taining a password. This password is required to be entered when the starting the Param-
eter Editor for the first time.

After downloading the installation files for the ASM Parameter Editor, simply run the file
setup.exe. Upon completion of the installation, start the ASM Parameter Editor and enter
the password obtained through the registration mentioned above. The user will then be
prompted to enter a user-defined password.

3.4 Creating a New Advanced Safety Module Project File

The creation of a new project file using the Parameter Editor is straightforward. The ASM
Parameter Editor guides the user while configuring the parameters for the ASM to ensure
that a predefined sequence is observed.

When creating a new project, the very first action the user must perform is to select the
type of ASM to be deployed in the application — either the SGD7S-OSB01A or the
SGD7S-OSB02A module.

The parameters are divided into groups based upon their function are listed below in the
sequence (order) they are to be configured:

1. » General Device Parameters: These parameters apply to the ASM in general and
include the FSoE Address of the ASM, the Limit Violation Deactivation Delay Time
(LvVDDT) and the Encoder Filter.

2. ), Motor and Encoder Parameters: These parameters are configured in accordance
with the actual electromechanical components deployed in the machine.

22
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Sigma-7 Series SERVOPACKs

Creating a Project using the Advanced Safety Module Parameter Editor

Example of Creating a New Advanced Safety Module Project File

I/0 Configuration Parameters: These parameters are applicable to the SGD7S-
OSBO02A module (with physical 1/0 terminals) only and are used to define the confi-
guration of the I/O ports, e.g. Digital Input or Digital Output, and their associated
attributes, e.g. Filter Time and Discrepancy Time in the case of digital inputs, or
Test Pulse Length for digital outputs.

Slot Parameters: Up to 10 slots can be configured with the available 16 safety
functions. A Safe Homing Position (SHP) function (only one per project) as well as
Mapping function can also be configured. In addition to the selection of a safety
function, the selection of an Activation Input and an Output Signal Type as well as
the associated Output Signal Behaviour can be performed in each slot. Additional
parameters associated with the selected Safety Function itself are also configured
during the configuration of a safety slot.

) Important!
i The General Device Parameters, the Motor and Encoder Parameters,

and the I/O Configuration parameters strongly influence the selection
possibilities in the configuration of the Slot Parameters. It is therefore
imperative that the General Device Parameters, the Motor and Encoder
Parameters, and the I/O Configuration parameters are configured cor-
rectly before proceeding with the Slot Parameters.

Important!

With respect to the General Device Parameters, once these parameters
have been checked, committed and confirmed and this dialog closes, it is
no longer possible to modify the selection “Will the Advanced Safety
Module be connected to an FSoE Master?” Once slot parameters have
been configured, i.e. checked, committed and confirmed, it is afterwards
not possible to edit any Motor and Encoder Parameters nor is it possible
to edit those I/0O Configuration parameters for which their I/O’s that have
been selected in the slot configuration(s).

The order in which the safety slots themselves are configured is immate-
rial.

3.5 Example of Creating a New Advanced Safety Module Project File

An example of how to create a new ASM project file is shown below. Before beginning
with the creation of the project, consider the following characteristics, features and
requirements of a hypothetical machine that will be used in this example:

1.

The ASM SGD7S-0SB02A will be deployed — a configuration of the 1/O ports is
therefore necessary

The ASM will be connected to an FSoE Master — virtual 1/0 can therefore be used
in the slot configuration

Linear Application with Rotary Motor:

B Sigma-7 Motor/Encoder: SGM7G-1ED7F** — 15 kW, 400Vac, 24-bit absolute
encoder, rated motor speed 1500 rpm, maximum motor speed 2000 rpm

B  Motor Encoder Usage: Absolute Multi-Turn

B External linear (2"%) encoder (Heidenhain®) with 20 um scale pitch — to be used
for safety only

B Sigma-7 Serial Converter Unit with 12-bit interpolation (JZDP-JOOO-OOO-E)
B Gearbox ratio: 10:1
B Ball screw pitch: 6 mm (6000 pym)

| | Advanced Safety Module - Application Manual - Version A - Revision O | en | 23



Creating a Project using the Advanced Safety Module Parameter Editor Sigma-7 Series SERVOPACKSs

Creating a New Project File

4. , 1/0 Configuration:

Port A: Digital Output Test Pulse A
Port B: Digital Output

Port C: Digital Output EDM

Port D: Digital Input

Port E: Digital Input Test Pulse A
Port F: Analog Input (0-10V)

Port G: G1: 4-20mA, G2: PT1000

5. ) Safety Slot Configuration:

One slot with safety function SLS (Safely Limited Speed) — a “safe motion” type
safety function

One slot with safety function SS1-r (Safe Stop 1, deceleration monitored and
time controlled) — a “safe standstill” type safety function (aka a stopping method
— this slot will be “linked” to the above slot via a “Limit Violation”)

One slot with safety function SMT (Safe Motor Temperature) — a “safe moni-
toring” type safety function

3.6 Creating a New Project File

Select the from the File menu New Project or click the following icon on the toolbar shown
inside the red rectangle:

Fig. 15: Start a new project icon on the toolbar

The following Create New Project dialog will appear:
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Fig. 16: Create New Project dialog

In accordance with the example characteristics and features given above, select SGD7S-
OSBO02A for the ASM7 Module Type.

For the project Description, up to 260 characters can be entered. This enables the user to
enter a meaningful and detailed description of the project. For this example, the following
was entered in the Create New Project dialog:

Fig. 17: Completed Create New Project dialog
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Click OK.

) Important!
i Once the OK button is clicked and this dialog closes, it no longer possible
to modify the ASM7 Module Type!

O For carriage return line feed (new line) inside the Description data entry
i field, use the short-cut key combination CTRL + Enter.

) The project Description can also be entered in the General Device
i Parameters dialog as well as in the Project Details window (lower left
grey area of the ASM Parameter Editor). The Project Details window dis-
plays the details of the current parameter project and provides a context
menu (right mouse click) for changing the project Description and for set-
ting a serial number.

Before proceeding to the configuration of the parameters, save the project by clicking the
icon on the toolbar inside the red rectangle:

Fig. 18: Save the current project icon on the toolbar

In the Save Project File dialog, select the directory, enter a file name and click the button
Save. Note that project files always have the file extension *.asm?7.

For path and file names, use only printable and permissible characters
i from the standard ASCII character set. Non-permissible standard ASCII
characters are the following; > <:"/\| ? *

The Project Details windowpane will now appear as shown below:
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Fig. 19: The Project Details windowpane

3.7 Configuring the General Device Parameters

In the windowpane Parameter Groups, click the General Device Parameters group. The
following dialog will appear as shown below:

Fig. 20: The General Device Parameters dialog

| | Advanced Safety Module - Application Manual - Version A - Revision O | en | 27



Creating a Project using the Advanced Safety Module Parameter Editor Sigma-7 Series SERVOPACKSs

Configuring the General Device Parameters

In accordance with item 2 of the characteristics, features and requirements given above

( & Chap. 3.5 ‘Example of Creating a New Advanced Safety Module Project File’

page 23), select Yes in the group box entitled Will the Advanced Safety Module be con-
nected to an FSoE Master? and in the data entry field for the FSoE Address the hexadec-
imal value 0x0007.

Enter the value 7000 in the data entry field for Limit Violation Deactivation Delay Time
(LVDDT). The parameter LVDDT is used to prevent output chatter. Click the icon € inside
the group box for LVDDT for more information.

The parameter Encoder Filter is applicable only when the safety function SLA (Safely
Limited Acceleration) will be used. Since SLA will not be implemented in this example
project, leave the default value of 1 as is.

The Advanced Safety Module Serial Number consists of a total of 15 digits (2 characters
and 13 numbers), e.g. D0207A000110004. Locate the serial number of the Advanced
Safety Module to be deployed and enter it exactly in the applicable data entry field.

Upon completion of the project file, a safe parameter container can be
j generated which can then be downloaded to the Advanced Safety
Module. The correct serial number is a prerequisite for the error-free
download of the binary safe container to the Advanced Safety Module.

The completed dialog for General Device Parameters should now appear similar to the
following (the Project Description and Serial Number are examples only):

Fig. 21: Completed General Device Parameters dialog
Click the yellow | checkandcommit. button. The Compare and Confirm dialog will appear:
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Fig. 22: Compare and Confirm dialog for the General Device Parameters

Since the Input Values and the Stored Values for the FSoE Address, LVDDT and Encoder
Filter are identical, click the Confirm button and the Compare and Confirm dialog closes.

) Important!
i With respect to the General Device Parameters, once the Confirm button
is clicked and this dialog closes, it is no longer possible to modify the
selection “Will the Advanced Safety Module be connected to an FSoE
Master?”

1

) For further details concerning the Compare and Confirm procedure,
i please refer to the Online Help utility of the ASM Parameter Editor by
simply clicking the icon on the toolbar inside the red rectangle:

Fig. 23: Help icon on the toolbar

3.8 Configuring the Motor and Encoder Parameters
In the windowpane Parameter Groups, click the Motor and Encoder Parameters group.

In accordance with item 3 of the characteristics, features and requirements given above
( % Chap. 3.5 ‘Example of Creating a New Advanced Safety Module Project File’
page 23):
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10.
1.
12

13.
14.

In the group box Basic Application, click Linear Application.
In the group box Motor Type, click Rotary Motor.
From the pull-down menu in the group box Motor/Encoder Type, select SGM7G-

***7*.
In the group box Motor Encoder Usage, click Absolute Multi-Turn. Leave the value
of 65535 for Multi-Turn Limit as is — do not change.

In the group box Motor Direction, select Forward (CCW). Note: Set Sigma-7
parameter Pn000.0 to 0.

In the group box Motor Maximum Speed, enter the value 2000.

In the group box External Encoder, click Used for safety only and from the pull-
down menu for Serial Converter Type, select JZDP-J***-***,

In the group box External Encoder Direction, click Equal to Motor Encoder.

Tip: Click the icon € inside the group box for External Encoder Direction for more
detailed information on how to make the correct selection.

Note: Set Sigma-7 parameter PnOOE.3 to 1.

In the group box External Encoder Scale Pitch, enter the value 2000. (20/0.01 ym =
2000)

In the group box Encoder Deviation, enter the value 1000.
In the group box Encoder Deviation Window, enter the value 1000.

Within the displayed graphic are two data entry fields for Gearbox Input and
Gearbox Output. Enter the value 10 in the Gearbox Input data entry field and enter
the value 1 in the Gearbox Output data entry field.

In the group box Linear Feed, enter the ball screw pitch 6000.

In the group box User Units Input Mode, leave the selection Set the user units
with graphical assistance as is — do not change.

Upon completion of the selections and data entries listed above, the Motor and Encoder
Parameters dialog will appear as shown below:

Fig. 24: Motor and Encoder Parameters dialog

Click the yellow | cheskandcommit. button. The Compare and Confirm dialog will appear:
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Fig. 25: Compare and Confirm dialog for the Motor and Encoder Parameters

Use the scrollbar at the right of the Compare and Confirm dialog and while scrolling down
verify that the Input Values and the Stored Values are identical. It is necessary to scroll to
the very bottom of the dialog in order to activate the Confirm button. If the Input Values
and the Stored Values for the Motor and Encoder Parameters are identical, click the Con-
firm button and the Compare and Confirm dialog closes.

Important!
i Once the Confirm button is clicked and this dialog closes, it is no longer
possible to modify:

— The Basic Application (Rotary or Linear Application)
— The Motor Type (Rotary or Linear Motor)

3.9 Configuring the I/O Parameters
In the windowpane Parameter Groups, click the I/O Configuration parameters group.

Prior to proceeding with the 1/0O configuration, it is instructive to review the port functions
available. In the pull-down menus for ports A to G, the function of the respective port can
be selected. The following table shows which assignments are possible for which port.

1/0 Port Function Types

Safe Function Type A B C D E F G1 G2
2-channel Digital Input J ® ° ° ° ) - -
2-channel Digital Input Test Pulse A — ] ° ° ° ° = -
2-channel Digital Input Test Pulse B ® - U ° ° o = —
2-channel Analog Input (0-10V) = - - = = ° - -
1-channel Analog Input (4-20mA) - - - = = - ° -
1-channel Analog Input (PT1000) - - - - = = = °
2-channel Digital Output ° ° ° ° - - - -
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Safe

no

Function Type A B C D E F G1 G2
Digital Output EDM ) ° ° ° - - - -

2-channel Digital Output Test Pulse ® o - - = = - -

e = Available

— = Not available

In addition, additional 1/0O port parameters are to be configured dependent upon the port
function as shown in the following table:

1/0 Port Parameter Dependencies

Port Function Filter Time Discrep- Test Pulse Channel
ancy Time Length Tolerance

00: None - = = -

01: Digital Input J ° = -

02: Digital Input Test Pulse A ° o - -

03: Digital Input Test Pulse B ° J - =

04: Analog Input (0-10V) - = o °

06: Analog Input (4-20mA and - - - -
PT1000)

07: Digital Output - = ° -

08: Digital Output EDM - = - -

09: Digital Output Test Pulse - - ° o

In accordance with item 4 of the characteristics, features and requirements given above
( & Chap. 3.5 ‘Example of Creating a New Advanced Safety Module Project File’
page 23), the I/O Configuration will now be carried out:

1.

10.
1.

In the group box Port A Function, click the pull-down menu and select Digital
Output Test Pulse A.

In the group box Port A Test Pulse Length, enter the value 100 in the data entry
field.

In the group box Port B Function, click the pull-down menu and select Digital
Output.

In the group box Port B Test Pulse Length, enter the value 50 in the data entry field.

In the group box Port C Function, click the pull-down menu and select Digital
Output EDM.

In the group box Port D Function, click the pull-down menu and select Digital Input.
In the group box Port D Filter Time, enter the value 250 in the data entry field.

In the group box Port D Discrepancy Time, enter the value 150 in the data entry
field.

In the group box Port E Function, click the pull-down menu and select Digital Input
Test Pulse A.

In the group box Port E Filter Time, enter the value 200 in the data entry field.

In the group box Port E Discrepancy Time, enter the value 150 in the data entry
field.
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13.
14.

Configuring the 1/0 Parameters

In the group box Port F Function, click the pull-down menu and select Analog Input
(0-10vdc).

In the group box Port F Channel Tolerance, enter the value 5 in the data entry field.

In the group box Port G Function, click the pull-down menu and select G1: 4-20maA,
G2: PT1000.

Upon completion of the selections and data entries listed above, the I/O Configuration
parameters dialog will appear as shown below:

Fig. 26: Completed I/O Configuration parameters dialog

) Important!
i The Test Pulse Length parameterised for Port A must be shorter than the
. L Filter Time parameterised at the corresponding input (to which the test

pulse returns) — in this example Port E. If this is not the case, the signal
received at the input is not interpreted as a test pulse, but rather as a
signal which activates the safety function parameterised with this partic-
ular input.

Click the yellow | checkandcommit. button. The Compare and Confirm dialog will appear:
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Fig. 27: Compare and Confirm dialog for the I/O Configuration parameters

Use the scrollbar at the right of the Compare and Confirm dialog and while scrolling down
verify that the Input Values and the Stored Values are identical. It is necessary to scroll to
the very bottom of the dialog in order to activate the Confirm button. If the Input Values
and the Stored Values for the I/O Configuration parameters are identical, click the Con-
firm button and the Compare and Confirm dialog closes.

3.10 Configuring the Slot Parameters

For the sake of convenience, the characteristics, features and requirements for safety slot
configuration (item 5, & Chap. 3.5 ‘Example of Creating a New Advanced Safety Module
Project File’ page 23) are given below:

B One slot with safety function SLS (Safely Limited Speed) — a “safe motion” type
safety function

B One slot with safety function SS1-r (Safe Stop 1, deceleration monitored and time
controlled) — a “safe standstill” type safety function (aka a stopping method — this slot
will be “linked” to the above slot via a “Limit Violation”)

B One slot with safety function SMT (Safe Motor Temperature) — a “safe monitoring”
type safety function

In accordance with the given above requirements, the safety slot configuration will now
be undertaken beginning with Slot 1:

1. In the windowpane Parameter Groups, click the Slot 1 Parameters group.

2. , Inthe group box Safety Function, click the pull-down menu and select SLS.

3. In the group box Activation Input, click the pull-down menu and select Vir-
tual Input 0.

4. , Inthe group box Output Signal Type, click the pull-down menu and select
Safe Port B: Digital Output.

5. » Inthe group box Output Signal Behaviour, click the pull-down menu and select
LOW during safe state.

6. In the group box Waiting Time t1, enter the value 7000 in the data entry field.

7. In the group box Monitoring Time t2, enter the value 3000 in the data entry field.

8. » Inthe group box Speed Limit s1, enter the value 7000 in the data entry field.

9. » Inthe group box Speed Limit s2, enter the value 700 in the data entry field.
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Upon completion of the selections and data entries listed above for Slot 1, the Slot 1
Parameters dialog will appear as shown below:

Fig. 28: Completed Slot 1 Parameters dialog
Click the yellow | cheskandcommit. button. The Compare and Confirm dialog will appear:

Fig. 29: Compare and Confirm dialog for the Slot 1 Parameters

Use the scrollbar at the right of the Compare and Confirm dialog (if necessary) and while
scrolling down verify that the Input Values and the Stored Values are identical. It is neces-
sary to scroll to the very bottom of the dialog in order to activate the Confirm button. If the
Input Values and the Stored Values for the Slot 1 Parameters are identical, click the Con-
firm button and the Compare and Confirm dialog closes.

Continuing with the configuration of the Slot 2 Parameters:
1. In the windowpane Parameter Groups, click the Slot 2 Parameters group.

2. . Inthe group box Safety Function, click the pull-down menu and select SS7-r.
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3. » Inthe group box Activation Input, click the pull-down menu and select Limit Viola-
tion Slot 1.

4. In the group box Output Signal Type, click the pull-down menu and select Vir-
tual Output 0.

5. In the group box Output Signal Behaviour, click the pull-down menu and select

HIGH during working safety function.

In the group box Waiting Time t1, enter the value 500 in the data entry field.

In the group box Monitoring Time t2, enter the value 1500 in the data entry field.
In the group box Speed Limit s1, enter the value 100 in the data entry field.

© |@ N |o

In the group box Speed Limit s2, enter the value 10 in the data entry field.

Upon completion of the selections and data entries listed above for Slot 2, the Slot 2
Parameters dialog will appear as shown below:

Fig. 30: Completed Slot 2 Parameters dialog
Click the yellow | checkanacommit. button. The Compare and Confirm dialog will appear:
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Fig. 31: Compare and Confirm dialog for the Slot 2 Parameters

Use the scrollbar at the right of the Compare and Confirm dialog (if necessary) and while
scrolling down verify that the Input Values and the Stored Values are identical. It is neces-
sary to scroll to the very bottom of the dialog in order to activate the Confirm button. If the
Input Values and the Stored Values for the Slot 2 Parameters are identical, click the Con-
firm button and the Compare and Confirm dialog closes.

Continuing with the configuration of the Slot 3 Parameters:

1.
2.
3.

In the windowpane Parameter Groups, click the Slot 3 Parameters group.
In the group box Safety Function, click the pull-down menu and select SMT.

In the group box Activation Input, click the pull-down menu and select
Safe Port D: Digital Input.

In the group box Data Input, click the pull-down menu and observe the available
choices: Safe Port F: Analog Input (0-10Vdc), Port G1: Analog Input (4-20mA), Port
G2: PT1000. Select Port G2: PT1000.

In the group box Output Signal Type, click the pull-down menu and select
Port C2: EDM Output.

In the group box Output Signal Behaviour, click the pull-down menu and select
HIGH after limit violation.

In the group box Temperature Limit tp1, enter the value 150 in the data entry field.

In the group box Temperature Limit tp2, enter the value 700 in the data entry field.

Upon completion of the selections and data entries listed above for Slot 3, the Slot 3
Parameters dialog will appear as shown below:

| | Advanced Safety Module - Application Manual - Version A - Revision O | en | 37



Creating a Project using the Advanced Safety Module Parameter Editor Sigma-7 Series SERVOPACKSs

Configuring the Slot Parameters

Fig. 32: Completed Slot 3 Parameters dialog

Click the yellow | cheskandcommit. button. The Compare and Confirm dialog will appear:

Fig. 33: Compare and Confirm dialog for the Slot 3 Parameters

Use the scrollbar at the right of the Compare and Confirm dialog (if necessary) and while
scrolling down verify that the Input Values and the Stored Values are identical. It is neces-
sary to scroll to the very bottom of the dialog in order to activate the Confirm button. If the
Input Values and the Stored Values for the Slot 3 Parameters are identical, click the Con-
firm button and the Compare and Confirm dialog closes.

The configuration and parameterisation of the example project is now complete. Before
proceeding with the creation of a safe parameter container, save the project by clicking
the icon on the toolbar inside the red rectangle:
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Fig. 34: Save the current project icon on the toolbar

) For path and file names, use only printable and permissible characters
i from the standard ASCII character set. Non-permissible standard ASCII
characters are the following; > <:"/\| ? *

3.11 Generating Parameter Files

After completion of the parameter configuration and all parameters have been checked
and committed, a validation check (which includes a final plausibility check) can be per-
formed. Upon successful validation, a checksum is generated. When subsequently cre-
ating the Safe Parameter Container, this checksum is applied to the safe container in
order to "protect" its contents. Prior to creation of a safe container, it is essential that a
successful validation check is performed.

To do this, press the Validate Parameter button in the Device menu or the button shown
in the following figure in the toolbar.

) It is not mandatory to first click on the Validate Parameter menu item from
i the menu bar or directly on the icon with the warning triangle in the
toolbar. When clicking on the Export Safe Container item in the menu bar
or directly on the corresponding icon in the toolbar, a validation check is
first performed automatically. The user can therefore skip the Validate
Parameter step and proceed directly to the Export Safe Container step. If
the validation fails, no Safe Container will be created.

1

If the validation check was successful, the tool displays the message "CRC calculation
successful: ...." with the resulting CRC32 checksum for the safe parameter container in
the message log. If the validation fails, an error message is displayed.

| | Advanced Safety Module - Application Manual - Version A - Revision O | en | 39



Creating a Project using the Advanced Safety Module Parameter Editor Sigma-7 Series SERVOPACKSs

Generating Parameter Files

If the parameter validation was successful, a binary safe container file can be generated.
This is done by pressing the Export Safe Container button.
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The tool opens a file save dialogue to enter the desired file name in the current output
directory. The default extension for the parameter files is ".bin", which indicates binary
content.

The parameter files are set to read-only after export to prevent accidental deletion. If the
same file is to be overwritten, the write protection must be removed. This can be done in
the file save dialogue by right-clicking on the existing file and removing the read-only
property as shown in the following figure.
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The tool increments an internal version counter and writes this value to both the project
file and to the binary safe parameter container when the following steps have been exe-
cuted:

1. » A parameter value has been modified.

2 The modified parameter value has been checked and committed.
3. » A new binary safe parameter container is generated.
4

The project is saved.

The last step completes the configuration. Save the project before closing the tool.
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3.12 CMIF Container Transfer

The generated parameter files can be downloaded to the Advanced Safety Module. The
Advanced Safety Module Parameter Editor offers a direct download function via the CMIF
interface to the SERVOPACK CmServer. Therefore, the PC with the installed tool
requires the installation of SigmaWin+ Version 7.40 (or later) including the communication
service CmServer.
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Communication with the SERVOPACK is only possible when one and
i only one software program uses the designated interface (typically USB).

For example, it is not possible to have an online connection to the SER-
VOPACK using SigmaWin+ and simultaneously use the Safe Container
Download function of the Advanced Safety Module Parameter Editor.
Otherwise, communication will fail. Either close SigmaWin+ or close the
Safe Container Download window of the Advanced Safety Module
Parameter Editor.

By clicking on CMIF Container Transfer in the Device menu the following download dia-
logue is displayed.

Downloading a safe con-
tainer file to the Advanced
Safety Module

1. ) Configure the connection to the SERVOPACK.

) At present, the port to which the SERVOPACK is connected can be
i only the USB port (Port#10 USB). Do NOT select an Ethernet con-
nection!

2. Click on the Connect button to connect the SERVOPACK.
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3. » When the connection is established, click on the Load File... button at the top right
of the dialogue.
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4. , Select the desired file in the Load Safe Container File dialogue. The serial number
currently associated with the safe container file is displayed in the file information
box and in the New Serial Number data entry field.
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5. ) Determine the serial number of the connected Advanced Safety Module. If the serial
number of the connected Advanced Safety Module matches the serial number dis-
played as described step 4, proceed to step 6.

If the serial number of the connected Advanced Safety Module differs from the
serial number displayed as described in step 4, the safe container file must be
updated with the serial number of the connected Advanced Safety Module.

Click the Update Serial No... button to apply the new serial number to the safe con-
tainer file.

The new serial number will be shown in the file information box (and in the New
Serial Number data entry field) and will be applied to the safe container file for
sending. Writing this serial number to the safe container file is not required. If, how-
ever, it is desired to make this serial number persistently associated with the safe
container file, click the button Write File.

) Important information for machine manufacturers engaged in
i serial production

4 Itis possible to assign a serial number without having to save the
safe container file again and again for each and every machine
axis. Use the one applicable safe container file and update the
serial number as required for the whole series. If identical machine
axes are to be furnished with the same safe container file, the serial
number is entered during the download (see step 5 above) without
having to save a new safe container file.

6. Click on the Send File button to start the download.
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Uploading a safe con-
tainer file from the con-
nected Advanced Safety
Module

7.

When the download is completed successfully, a Write Success message will be
displayed.

In addition to downloading, it is also possible to upload a parameter file from the con-
nected Advanced Safety Module.

1.

2,

Configure the connection to the SERVOPACK.

) At present, the port to which the SERVOPACK is connected can be
i only the USB port (Port#10 USB). Do NOT select an Ethernet con-
nection!

Click on the Connect button to connect the SERVOPACK.
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3. When the connection is established, click on the Receive File button to start the
upload.

4. ), If the upload was successful, save the received container file by clicking on the
Save Received File button.

Motor and Encoder The safety-related servo parameters contain information about the motor and encoder
Parameter Check button configuration of the SERVOPACK and are managed by the Advanced Safety Module.
(Servo Parameter Confir- This information is held in the SERVOPACK, but it is also managed in the Advanced
mation) Safety Module with different parameter numbers.

When the unit consisting of SERVOPACK and Advanced Safety Module is switched on,
the values of this parameter group stored in the SERVOPACK are compared with the
values of the corresponding parameters in the Advanced Safety Module. If the values do
not match, alarm A.EC1 (Safety-related Servo Parameter Unmatch Alarm) is displayed.
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ASM?7 Initialize button

The safety-related servo parameters that do not match between SERVOPACK and
Advanced Safety Module can be displayed by pressing the button Motor and Encoder
Parameter Check.

Non-matching parameters are displayed in the following dialogue box.

At the same time the following message appears in the Message Log:

Safety related servo parameter confirmation failed. Number of
unmatching parameters: 2

If all parameters match, the following message is displayed in the Message Log without
the Servo Parameter Confirmation dialogue box being displayed.

Safety related servo parameter confirmation successful

O When using the Digital Operator, the function described here corresponds
i to Fn042 (Safety-related Servo Parameter Confirmation).

1

If an Advanced Safety Module that is already in operation is initialized with a new SER-
VOPACK, the ASM7 Initialize button is helpful.

This Advanced Safety Module has the following features:

B SERVOPACK serial number stored
B Optional: Safe container stored
B Optional: Homing information stored

If an Advanced Safety Module with these properties is connected to a new SERVOPACK,
the Safety Module Confirmation Alarm (A.ECO) is displayed.

By clicking on the ASM7 Initialize button, the stored serial number of the SERVOPACK,
the homing information and the safe container in the non-volatile memory of the
Advanced Safety Module are deleted.
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®  Click on the ASM7 Initialize button.

A message box will appear with the instructions to switch the power supply of the
SERVOPACK off and on.

Fig. 35: ASMY Initialize Cycle Power Dialogue box

After clicking OK in the message box, the message "ASM7 Parameter Initialization suc-
cessful" will appear.
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The initialization of the Advanced Safety Module can then be continued as described in
the product manual.

) When using the Digital Operator, the function described here corresponds
i to Fn043 (Safety Option Module Initializing Parameter Setting).

i
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4  Application Example: Rotary Table
—

>

1
Gear
1:10

Servo

Fig. 36: Rotary table application

This application consisting of a gearbox and a rotary motor is to be realised with the
safety requirements described below.

User unit:

B Position unit in degrees
B Speed in deg/s

Safety requirements A light curtain is hardwired to the Advanced Safety Module and sets the servomotor to
STO (Safe Torque Off).

The SLS (Safely Limited Speed) function is activated via FSoE. In the Advanced Safety
Module, we realise this via virtual input 0.

The maximum allowable speed is one turn per second.

A safe output is connected to a safety relay which, in the event of STO, activates a
warning light and switches off the downstream axes.

Warning
Light

Port A
Port B

Safety
Relays

Y

Light Cuftajn

~ 0>

Fig. 37: Rotary table application - Safety requirements

) Yaskawa's scope of supply in the above illustration is limited to the
T Advanced Safety Module (ASM?7).

i

Starting the Advanced

Safety Module Parameter () The creation of a project with the Advanced Safety Module Parameter
Editor and Login i Editor is described in detail in chapter & Chap. 3 ‘Creating a Project
. L using the Advanced Safety Module Parameter Editor’ page 22. Only par-

ticularly significant points for the example application are described here.

You must enter the password to obtain full parameterisation rights when starting the appli-
cation.
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Fig. 38: Login

The main window is displayed when the application is started. You can now create a new

project.

Fig. 39: Successful Start of the Application

54
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Application Example: Rotary Table

Creating a Project

Fig. 40: New Project

Before parameters can be configured, a project must first be created. Click New Project in

the File menu to create a new project. The Create New Project dialogue box appears.

Fig. 41: Create New Project - Rotary table application
Select the ASM7 Module Type:

m SGD7S-OSBO1A (FSOE only)
m  SGD7S-OSB02A (FSoE + 10)

) Important!
i Once the OK button is clicked and this dialogue closes, it no longer pos-
sible to modify the ASM7 Module Type!

A short description of the application project should always be entered.

After validating the Create New Project dialogue, the parameter groups on the left are
active and the parameters are available for editing.
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Sigma-7 Series SERVOPACKSs

Fig. 42: New Project Ready for Editing

Here you can check whether you have selected the correct ASM7 Module Type.

The displayed parameter groups must always be edited starting at the top. When the
parameterisation of a parameter group has been completed, the | checkand commit. hutton
becomes active. Clicking this button displays the Compare & Confirm dialogue box to
check and confirm the stored values.

56
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General Device Parame- Select the parameter group General Device Parameters.
ters

Fig. 43: General Device Parameters group

In the General Device Parameters group, indicate whether you are using an FSoE master

or not, and if so, enter the FSoE address.

You also enter the serial number of the Advanced Safety Module, which is indicated on
the sticker of the board.

Before you install the SERVOPACK (e.g. in a control panel), please
i ensure that the serial number of the product is recorded. If the SERVO-
PACK is already installed, the serial number can also be read out with
SigmaWin+.

1

If you are unsure about the meaning of a certain parameter, use the € buttons that dis-
play a small help text.
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Fig. 44: Limit Violation Deactivation Delay Time Help Text

When you have entered all values and made all selections, click on the | cneckand commit
button.

Fig. 45: Compare & Confirm General Device Parameters

In the Compare & Confirm dialogue you will now see the previous entries with the corre-
sponding parameter number.

If all input values match the saved values, click on Confirm!

Motor and Encoder Now select the next parameter group Motor and Encoder Parameters.

Parameters Let's assume you have only one motor and no second encoder (with this configuration,

SIL 2 is achievable) and want to use the Advanced Safety Module for a rotary table appli-
cation.

58 | | Advanced Safety Module - Application Manual - Version A - Revision O | en |



Sigma-7 Series SERVOPACKSs Application Example: Rotary Table

S
, Gear
1:10

Servo

Fig. 46: Rotary table application

Fill in the Motor and Encoder Parameters group and click on | checkana commit| gfter completing
the entry.

User unit:

B Position unit in degrees
B Speed in deg/s

Fig. 47: Motor and Encoder Parameters

Basic Application: Rotary Application
Motor Maximum Speed (rpm): 6000
The maximum motor speed is determined by the motor

used.
External Encoder: None or used for safety
Motor/Encoder Type: SGM7J-***7*
Motor Encoder Usage: Absolute Multi-Turn
Multi-Turn Limit: 9

Since a gearbox with a reduction of 1:10 is used, the
value 9 must be selected here if the rotary table is to
be set to 360 degrees.

Motor Direction: Forward (CCW)
Encoder Deviation (degree): 5

Encoder Deviation Window (ms): 10

Position Units: degree
Velocity Units: degreels
Gearbox Input: 10

Gearbox Output: 1
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1/0 Configuration

Slot 1 Parameters

Now select the next parameter group I/O Configuration.

Fill in the I/O Configuration group and click on | creckana commit| after completing the entry.

Fig. 48: I/0O Configuration

Port A Function: Digital Input

Port B Function: Digital Output

Port A Filter Time (ms): 100
If the light curtain output works via relays, note that relays
bounce (20 ms). Due to this assumption, the value 100 ms was

chosen.
Port A Discrepancy 200
Time (ms): The Discrepancy Time was chosen according to the previous

assumption if a delay occurs due to a test pulse.
When setting these values, the test pulse lengths given in the
light curtain operating instructions must be observed.

Port B Test Pulse 10

Length (ms):

Warning
Light

Port A
Port B

Safety
Relays

Light Cu

g
=1
~w»n>

Fig. 49: Rotary table application - Safety requirements

Now select the next parameter group Slot 1 Parameters.

) Each slot can only contain one safety function!

1

1

60

| | Advanced Safety Module - Application Manual - Version A - Revision 0 | en |



Sigma-7 Series SERVOPACKSs Application Example: Rotary Table

Fig. 50: Slot 1 Parameters

Safety Function: STO
Activation Input: Safe Port A: Digital Input
Output Signal Type: Safe Port B: Digital Output

Output Signal Behaviour: LOW during safe state

Slot 2 Parameters Now select the next parameter group Slot 2 Parameters.

) Each slot can only contain one safety function!

1

1
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Sigma-7 Series SERVOPACKs

Writing a Save Container
File

Fig. 51: Slot 2 Parameters

Safety Function:
Activation Input:

Output Signal Type:
Output Signal Behaviour:
Waiting Time t1 (ms):
Speed Limit s1 (degree/s):

Speed Limit s2 (degree/s):

Monitoring Time t2 (ms):

Save your project file.

Fig. 52: Save Project File

SLS

Virtual Input 0

The SLS function is activated via the virtual input 0.
Virtual Output 0

None

0

3600

6000 rpm (Motor Maximum Speed) / 10 (Gear Ratio = 1:10) =
600 rpm

600 rpm = 10 turns/s = 3600°/s

360

The maximum allowable speed is one turn per second =
360°/s

100

If there are unused slots in your parameter set, the following information appears.
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Fig. 53: Unused Slots
Calculate a Checksum for Validation.

Fig. 54: Calculate a Checksum for Validation

Finally, all parameter groups must be displayed with a green background.

Write a Safe Container File.

Fig. 55: Write a Safe Container File
Save the Binary File.
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Fig. 56: Save Binary File

Parameter File Transfer Transfer your Save Container File to the Advanced Safety Module.

Fig. 57: Start the CMIF Download

Fig. 58: Safe Container Download
1. ) Click on the Load File button.
2. ), Check your file name in the File Information Box.

3. . Check the serial number of your Advanced Safety Module in the File Information
Box.
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4.
5.
Starting the execution on
the Advanced Safety
Module
1.
2.
3.

Click on the Connect button and after making sure that the correct file has been
selected, click on the Send File button to start the download.

) At present, the port to which the SERVOPACK is connected can be
i only the USB port (Port#10 USB). Do NOT select an Ethernet con-
nection!

[l |

When the download is completed successfully, a Write Success message will be
displayed.

Cycle the power of the SERVOPACK.

= After about 5 seconds HWBB should disappear and the servo can be switched
on.

A.9CO indicates that slot 1 (STO) is activated, immediately HWBB (STO) is dis-
played.

A.9C1 indicates that Slot 2 (SLS) is activated.
= If no safety function is active, only the green LED lights up.
When a safety function is activated, the red LED starts flashing.

If the red LED lights up continuously, the Advanced Safety Module has set the
SERVOPACK to the safe state (STO).

| | Advanced Safety Module - Application Manual - Version A - Revision O | en | 65



Commissioning of an Advanced Safety Module via TwinCAT 3 Sigma-7 Series SERVOPACKSs

Hardware Setup > EK1914 | EtherCAT Coupler with Integrated Digital Standard and Safety I/Os

5 Commissioning of an Advanced Safety Module via TwinCAT 3

5.1 Hardware Setup
5.1.1 C6915-0010 | Fanless Control Cabinet Industrial PC | Intel Atom®

Fig. 59: Beckhoff PLC C6915

The C6915 industrial PC is designed for installation in control cabinets. The compact
housing is equipped with a 3%.-inch motherboard with Intel Atom® with up to four cores.
All connections of the PC are located on the front of the housing. The industrial PC is
cooled by internal cooling fins without a fan and allows operation up to 55 °C.

5.1.2 EK1914 | EtherCAT Coupler with Integrated Digital Standard and Safety 1/Os

Fig. 60: Beckhoff EtherCAT coupler EK1914
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Hardware Setup > EL6910 | TwWinSAFE Logic

The EK1914 EtherCAT coupler combines the functionalities of the EK1100 EtherCAT cou-
pler with standard and safe digital 1/0s. The resulting compact design is particularly suit-
able for applications with a low number of 1/Os. Like the EK1100, the EK1914 can be
extended with all EL/ES terminals. The EK1914 has four digital inputs and four digital out-
puts as well as two fail-safe inputs and two fail-safe outputs.

5.1.3 EL6910 | TwinSAFE Logic

Fig. 61: Beckhoff TwinSAFE Coupler EL 6910

The TwinSAFE Logic EL6910 can establish 212 connections to other TWinSAFE devices.
Several EL6910s can be cascaded in a TWinSAFE network with up to 65,535 TwWinSAFE
devices.

) The EL6910 EtherCAT terminal has certified safety function blocks that
i are configured according to the application. Safety functions such as
emergency stop, safety door monitoring, two-hand control, etc. can thus
be selected and linked very easily. All function blocks can be intercon-
nected and are supplemented by operators such as AND, OR, etc.

1

In addition to the Safety over EtherCAT protocol, the EL6910 also supports TwinSAFE SC
technology. TwWinSAFE SC enables secure data transmission from standard EtherCAT
1/Os with the identifier -009x (TwinSAFE SC extension) to the TwinSAFE Logic EL6910.
The EL6910 also supports the processing of analogue signals (16/32 bit, signed and
unsigned). These signals are sent to the logic from standard, TwinSAFE SC or Safety
over EtherCAT 1/Os. This allows analogue signals to be analysed within the logic,
checked for plausibility and subjected to a "voting". For safety reasons, at least one of the
data sources must be a TwWinSAFE SC component. The other data can come from other
standard I/Os, drive controllers or measuring transducers. The entire calculation and
scaling is carried out in the safety-related TwinSAFE Logic EL6910 at the SIL 3/PL e
safety level. Certified components such as ADD, SUB, MUL, DIV, but also more complex
ones such as Counter, Limit or Compare are available for processing analogue signals.

The required functions are programmed with the TwinCAT Safety Editor under TwinCAT
3.1 and loaded into the TwinSAFE Logic EL6910 via the fieldbus.
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Hardware Setup > EL1904 | 4-Channel Digital Input Terminal, TWinSAFE, 24 V DC

5.1.4 EL1904 | 4-Channel Digital Input Terminal, TWinSAFE, 24 V DC

Fig. 62: Beckhoff TwinSAFE input terminal EL1904

The EL1904 Safety EtherCAT terminal is a digital input terminal for sensors with potential-
free contacts for 24 V DC. The EtherCAT terminal has four fail-safe inputs.
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Hardware Setup > EL9410 | Power Supply Terminal for E-bus Refresh, with Diagnostics

5.1.5 EL9410 | Power Supply Terminal for E-bus Refresh, with Diagnostics

Fig. 63: Beckhoff power supply terminal EL9410

The EL9410 power supply terminal is used to refresh the E-bus, via which the data
exchange between EtherCAT coupler and terminals takes place. Each EtherCAT terminal
requires a certain current from the E-bus. This current is fed into the E-bus by the power
supply unit of the respective EtherCAT coupler. In configurations with a large number of
EtherCAT terminals, the EL9410 can be used to increase the power supply of the E-bus
by 2 A. The EL9410 has a diagnostic function that is displayed via LED and in the
process image.
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Prerequisite for the Configuration

5.1.6 EL2904 | 4-Channel Digital Output Terminal, TwinSAFE, 24 V DC

Fig. 64: Beckhoff TwinSAFE output terminal EL2904

The EL2904 Safety EtherCAT terminal is a digital output terminal with four channels. It
switches 24 V DC actuators with up to 0.5 A current per channel. If the EtherCAT terminal
detects an error, it switches off automatically (fail-stop).

5.2 Prerequisite for the Configuration

B Software: TwinCAT 3 Build 4024.10

This software version has been updated on the computer and the Beckhoff PLC.
B Firmware versions:

— SERVOPACK SGD7S: 002F_F910

— Interface version: 0008-0015

— Advanced Safety Module: 0007 or higher
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Commissioning of an Advanced Safety Module via TwinCAT 3

5.3 Creating a new TwinCAT Project

Creating a new TwinCAT Project > Creating a New TwinCAT Project File

5.3.1 Creating a New TwinCAT Project File
1. » Select: Menu File = New = Project...

Fig. 65: TwinCAT 3 - Create new project
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Creating a new TwinCAT Project > Creating a New TwinCAT Project File

2. ), Select the TwinCAT XAE Project (XML format) project template in the dialogue box
that opens.

Fig. 66: TwinCAT 3 - Create new project - Select TwinCAT XAE Project

= In the field Name: the file name can be changed, taking into account the file
path conventions of the operating system. Dots in the name are not allowed.

™

) If the Create directory for solution checkbox is selected, all files
i created in connection with this application are stored in the
same project folder directory.

3. » Confirm the creation of the new TwinCAT project file with OK.
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Creating a new TwinCAT Project > Creating a New TwinCAT Project File

Fig. 67: TwinCAT 3 - New TwinCAT project created
The nodes displayed in the project folder have the following meaning:

SYSTEM: Routes, Licences, Task, Real-time
MOTION: NC configuration

PLC: PLC programming

SAFETY: Safety programming

C++: Creation of C++ modules

ANALYTICS: Analysis

I/O: Hardware configuration

General notes The TwinCAT system can only be configured or programmed when it is in configuration
mode. Scanning the fieldbus is also only possible in configuration mode. This is indicated
by the TwinCAT icon (Restart TwinCAT (Config Mode)) with a purple background in the
task bar.

Fig. 68: TwinCAT 3 - Restart TwinCAT (Config Mode)
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Creating a new TwinCAT Project > Scanning the Hardware Configuration

) The nodes PLC and SAFETY are completely separated, communication
i (in the sense of programming) between these areas usually only takes
. L place by linking variables from the node PLC to the node SAFETY (see

& Chap. 5.3.5.1 ‘Combining ErrorAcknowledgement.sds and Run.sds
with a Standard Signal’ page 90).

Fig. 69: TwinCAT 3 - PLC and SAFETY are separated items

5.3.2 Scanning the Hardware Configuration

) You can find the Sigma-7 ESI file (ESI = EtherCAT slave information) on
i our homepage www.yaskawa.eu.com = Service & Training = Download
. L Center by searching for "Sigma-7 Advanced Safety Module ESI".

Store the ESl file in the following directory before scanning the hardware
configuration: This PC = Windows (C:) = TwinCAT = 3.1 = Config = lo
= EtherCAT. If the ESI file is in this directory, the SERVOPACK wiill also
be found with the Advanced Safety Module installed.

74
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Creating a new TwinCAT Project > Scanning the Hardware Configuration

Fig. 70: TwinCAT 3 - Local path for Sigma-7 ESI file
1. ) Scan the hardware configuration to find the devices present on the fieldbus.

() A device is the connection from the PC to the fieldbus.

1

—

Fig. 71: TwinCAT 3 - Scan Hardware configuration
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Creating a new TwinCAT Project > Scanning the Hardware Configuration

2. ), Confirm the note that not all types of devices can be found automatically.

Fig. 72: TwinCAT 3 Hint - Not all types of devices can be found automatically
3. » Confirm the newly found device.

Fig. 73: TwinCAT 3 - New 10O devices found
= This device is the EtherCAT master.

) If the Sigma-7 ESI file is not placed in the correct directory, the
i device will only be referred to and found as a box.

[l |
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Creating a new TwinCAT Project > Scanning the Hardware Configuration

4. , Click Yes in the Scan for boxes dialogue box.

Fig. 74: TwinCAT 3 - Scan for boxes
5. » The devices found are now displayed under the Devices node.

=

) In the screenshot, 'Term 1 (EK1914)' is expanded. This is not
i the default view, the term must be expanded by clicking on it!

[l |

Fig. 75: TwinCAT 3 - Found devices after scanning for boxes
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Creating a new TwinCAT Project > Creating a Safety Project
5.3.3 Creating a Safety Project

1. ) Use the context menu of the SAFETY node to create a new safety project via Add
New ltem....

Fig. 76: TwinCAT 3 - SAFETY - Add New ltem
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Creating a new TwinCAT Project > Creating a Safety Project

2. ) Adialogue box opens, select TwinCAT Safety Project Preconfigured Inputs and
assign a name to the project.

O In our example, the project was given the name 'Safety_Prog'.

1

[l |

Fig. 77: TwinCAT 3 - SAFETY - Add New ltem - Select TwinCAT Safety Project Preconfig-
ured Inputs
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Creating a new TwinCAT Project > Creating a Safety Project

3. » Use the Add button to create the safety project.

Fig. 78: TwinCAT 3 - SAFETY - Add New ltem - Select TwinCAT Safety Project Preconfig-
ured Inputs - Create Safety Project
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Creating a new TwinCAT Project > Creating a Safety Project

The TwinCAT Safety Project Wizard now opens. Select the setting Hardware Safety
PLC as the target system and the graphical editor as the programming language.
Author and internal project name can be freely chosen.

) We recommend not choosing Safety C as the programming lan-
guage, because in that case there are no certified function blocks

1 available, these must be programmed yourself (and are also not
certified!).

Make the selection as shown in the figure and then confirm by clicking OK.

Fig. 79: TwinCAT 3 - TwinCAT Safety Project Wizard
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Creating a new TwinCAT Project > Creating a Safety Project

= The created safety project is now created in the Solution Explorer under the
SAFETY node.

Fig. 80: TwinCAT 3 - Safety Project is created in the Solution Explorer
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Creating a new TwinCAT Project > Creating a Safety Project

O) Before the safety project can be linked with the physical TwinSAFE
i terminal EL6910, the hardware configuration must be scanned!

[l |

By selecting the Target System node, the assignment of the safety project to the
physical TwinSAFE terminal EL6910 (for example) is carried out.

The Target System is selected by double-clicking on the Target System node.

Fig. 81: TwinCAT 3 - Select Target System EL6910 for Safety Project
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Creating a new TwinCAT Project > Creating a Safety Project

6. ) The target system is set to EL6910 via the drop-down list and linked to the EL6910
terminal via the link button  next to Physical Device.

Fig. 82: TwinCAT 3 - Choose physical terminal for mapping

Fig. 83: TwinCAT 3 - Physical device is mapped

= Term 2 (EL6910) is now entered in the field next to Physical Device, and the
hardware address has also been recognised.

The two checkboxes Take over Safety Alias Device names (Connection Info
Data names will also be adjusted) and Take over Standard Alias Device names
should be selected, as this ensures consistent naming (and thus easy recogni-
tion) even of alias device names.

84
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Creating a new TwinCAT Project > Importing the Alias Devices from the I/O Configuration

TwinSAFE address
i — The TwinSAFE terminal (EL6910) has a 10-position DIP
g9 switch on the side via which a hardware address must be
assigned.

— TwinSAFE addresses from 1 to 1023 are available.

— Address 0 is not a valid TwinSAFE address!

— The EtherCAT coupler (EK1914) must also have an address
different from 0!

— Each set TwinSAFE address may only occur once within a
network/configuration!

7. » Save the configuration with Save all.

Fig. 84: TwinCAT 3 - Save all

5.3.4 Importing the Alias Devices from the 1/0 Configuration

The communication between the EL6910 TwinSAFE terminal and the I/O level is realised
via an alias level. In this alias level (sub-node Alias Devices), corresponding alias devices
are created for all safe inputs and outputs, but also for standard signals. This can also be
done automatically for the safe inputs and outputs using the 1/0O configuration. The con-
nection- and device-specific parameters are set via the Alias Devices.

In the TwinSafeGroup1 there are already two alias devices that the TwinCAT Safety
Project Wizard has created:

B ErrorAcknowledgement.sds
ErrorAcknowledgement is to be linked to a PLC output or a standard input (such as a
push button) and used to acknowledge safety group errors: An error must additionally
be acknowledged manually so that it is reset.
Linking standard variables is always a two-step process: First they must be linked
from within the logic to the alias, and then from the alias to the PLC or the physical
I/Os.
ErrorAcknowledgement is already important when going online with the PLC project.
In this case, the signals of the safety PLC indicate that there is a communication error
(or ComErr). To reset the communication error, a 0 = 1 = 0 transition must be seen
on the ErrorAcknowledgement signal.

B Run.sds
Run/Stop sets the complete TwinSafeGroup in Run mode (activated) or in Stop mode
(deactivated).
When working on a safety system (e.g. plugging or unplugging), an error occurs if the
TwinSafeGroup concerned is not in Stop mode. In addition, for machines with several
safety areas (and thus several TwinSafeGroups), each area can be specifically set to
Run or Stop mode.
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Creating a new TwinCAT Project > Importing the Alias Devices from the I/O Configuration

= Start the automatic import of the alias devices from the I/O configuration via the
context menu of Alias Devices.

Fig. 85: TwinCAT 3 - Import Alias Device(s) from 10 configuration
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Creating a new TwinCAT Project > Importing the Alias Devices from the I/O Configuration

2. ) A selection dialogue opens in which the individual terminals to be imported can be
selected.

N

) Only select the terminals that are also used in the safety project, as
i an error is reported if alias devices of terminals not used in the
safety project are present!

[l |

Fig. 86: TwinCAT 3 - Select Alias Devices from 10 tree

= After closing the dialogue via OK, the alias devices are created in the safety
project.

Fig. 87: TwinCAT 3 - Importing and mapping of Alias Devices succeeded
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Creating a new TwinCAT Project > Importing the Alias Devices from the I/O Configuration

After importing, you can access the inputs and outputs of the safety terminals in
the safety project. This would not have been possible before.

Fig. 88: TwinCAT 3 - Alias Devices in TwinSafeGroup imported
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Creating a new TwinCAT Project > Importing the Alias Devices from the I/O Configuration

3. ) Double-click on the alias device in the safety project structure to open the settings.
The Linking tab contains the FSoE address, the checkbox for setting as External
Device and the link to the physical I/0 device.

Actually, the FSoE address should be transferred automatically from the hardware
address (dip switch); if this is not the case, the FSoE address must be written man-
ually into the corresponding field.

To be on the safe side, press the refresh button in advance so that the current
status of the configuration is displayed.

Fig. 89: TwinCAT 3 - Properties of the Safety Project structure
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Creating a new TwinCAT Project > Safety Programming in the TwWinSAFE Group

=
) With the Advanced Safety Module, the FSoE address is trans-
i mitted by the Safe Container. Therefore, before importing the
alias devices, the container should be in the Advanced Safety
Module and the corresponding inputs should also be mapped.

The Safe Container is created using the Advanced Safety
Module Parameter Editor.

The Advanced Safety Module does not have a dip switch, the
FSoE address is only assigned via the Advanced Safety
Module Parameter Editor!

Fig. 90: TwinCAT 3 - Properties of the SGD7S Alias Device

5.3.5 Safety Programming in the TwinSAFE Group
5.3.5.1 Combining ErrorAcknowledgement.sds and Run.sds with a Standard Signal

This step must be carried out before the safety programming of the Twin-SAFE group can
be carried out.
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1. » ErrorAcknowledgement.sds and RUN.sds must always be linked to a standard
signal. Therefore, we now create a PLC programme and declare two Boolean varia-
bles (RUN, ERR ACK).

Right-click in the PLC node and select Add New ltem....

) Run and ErrACK of the TwinSAFE Group

i Error acknowledgement is not performed automatically, i.e. the

— - ERR ACK input must always be linked to a standard signal. For the
EL6910 and newer logics, the RUN input must also always be
linked to a standard signal.

Fig. 91: TwinCAT 3 - Add New ltem in PLC
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2. ) In the dialogue box that opens, select Standard PLC Project, assign a name to the
new project and create the project with Add.

O In our example, the project was given the name "PLC_Safety

i Project”.

[l |

Fig. 92: TwinCAT 3 - Create Standard PLC Project
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= The project structure is now created in the Solution Explorer.

Fig. 93: TwinCAT 3 - Standard PLC Project created
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3. » Open the MAIN PLC programme.

Y
)

1

[l |

The MAIN PLC programme is opened by double-clicking on the
MAIN node.

Fig. 94: TwinCAT 3 - Open MAIN PLC program
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4. ,, Two Boolean variables are declared in MAIN, which we subsequently need for
ErrorAcknowledgement.sds and Run.sds:

B bErrACK AT %Q* : BOOL,;
B bStartStop AT %Q* : BOOL,;

) In TwinCAT, the actual addresses of the I/Os are of no interest, and
i there is no direct access to them. Therefore, one declares a vari-
L able with %I* as input and with %Q* as output. Once the pro-

gramme has been translated, these variables can then be assigned
to the physical inputs and outputs.

The variables must be entered manually.

Fig. 95: TwinCAT 3 - Variables in MAIN PLC program

=

O) ErrorAcknowledgement.sds is an input in the safety project,
i therefore the variable must be declared as an output (%Q*) in
the standard PLC.

5. ) Save the programme.

Fig. 96: TwinCAT 3 - Save all
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6. ) Activate the configuration.

Fig. 97: TwinCAT 3 - Activate Configuration
= Confirm the activation of the configuration.

Fig. 98: TwinCAT 3 - Activate Configuration Dialog box
A restart of the TwinCAT system in Run Mode is not necessary.

() The message that alias devices of terminals are present, which

ﬁ are not included in the safety project, only appears after a
. restart of the TwinCAT system (see & Chap. 5.3.4 ‘Importing
the Alias Devices from the I/O Configuration’ page 85).

Fig. 99: TwinCAT 3 - Restart TwinCAT System in Run Mode - Cancel
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7. Link the variables to the alias devices.

™

) By linking the variables to the alias devices, the connection
i between the standard PLC and the safety project is established.

[l |

Double-click on ErrorAcknowledgement.sds in the Solution Explorer to call up the
alias device.

Fig. 100: TwinCAT 3 - ErrorAcknowledgement Alias Device in Solution Explorer

8. » Inthe main window, click on the link button on the right side of the Linked to: field.

Fig. 101: TwinCAT 3 - ErrorAcknowledgement - Link Button
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9. ) Select the variable bErrAck and confirm the dialogue box with OK.

O Depending on the number of integrated terminals, you have to
i scroll down in the dialogue box to see the variables.

[l |

Fig. 102: TwinCAT 3 - Attach Variable bErrAck to ErrorAcknowledgement
= The Linked to: field shows that the link has been successfully established.

Fig. 103: TwinCAT 3 - Variable bErrAck attached to ErrorAcknowledgement
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10.,. Double-click on Run.sds in the Solution Explorer to call up the alias device.

Fig. 104: TwinCAT 3 - Run Alias Device in Solution Explorer
11., In the main window, click on the link button on the right side of the Linked to: field.

Fig. 105: TwinCAT 3 - Run - Link Button
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12.) Select the variable bStartStop and confirm the dialogue box with OK.

Fig. 106: TwinCAT 3 - Attach Variable bStartStop to Run

= The Linked to: field shows that the link has been successfully established.

Fig. 107: TwinCAT 3 - Variable bStartStop attached to Run

100 | | Advanced Safety Module - Application Manual - Version A - Revision O | en |



Sigma-7 Series SERVOPACKSs Commissioning of an Advanced Safety Module via TwinCAT 3

Creating a new TwinCAT Project > Safety Programming in the TwWinSAFE Group

13., Save the programme.

Fig. 108: TwinCAT 3 - Save all
14.) Activate the configuration.

Fig. 109: TwinCAT 3 - Activate Configuration
= Confirm the activation of the configuration.

Fig. 110: TwinCAT 3 - Activate Configuration Dialog box

A restart of the TwinCAT system in Run Mode is not necessary.

Fig. 111: TwinCAT 3 - Restart TwinCAT System in Run Mode - Cancel
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5.3.5.2 Configuring a Safety Function Block in the TWinSAFE Group

1. ) Double-click on the TwinSafeGroup1.sal safety application in the Solution Explorer
to open an empty safety application.

The TwinCAT Safety Project Wizard has automatically created the first "network".
The safety programme is written with the function plan (FUP) and is divided into
"networks". Network1 can be renamed to a meaningful name (such as safeAnd).

Fig. 112: TwinCAT 3 - Start Programming in TwinSafeGroup1
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TwinSAFE group

i Safety programming takes place in the TwinSAFE group (here:
- 5 TwinSafeGroup1.sal).

TwinSAFE groups are a way to logically separate safety pro-
grammes. If an application consists of, for example, two physi-
cally separate work cells that are both controlled by the same
TwinSAFE EL6900 safety PLC, it makes sense to separate the
logic into two separate TwinSAFE groups, since logically they
are two different machines.

The purpose of the groups is to manage error responses. If a
safety malfunction is detected, then the entire group goes into a
faulty state, all outputs return to their "safe" state (i.e. logical
"0"), and the error must be acknowledged with the error
acknowledgement signal. In the event that you have two physi-
cally separate machines controlled by the same safety PLC, it
makes sense to separate them into two groups so that a mal-
function of the safety device on one machine does not cause
the other machine to stop.

A communication error is indicated by the output (COM ERR) of
the TwinSAFE group and acknowledged via the input ERR
ACK. A function block error is indicated by the FB ERR output
and acknowledged by the same ERR ACK input as the commu-
nication error. The safe state of the outputs of the TwinSAFE
group is only cancelled when the error is no longer present and
has been acknowledged.

In addition, the TwinSAFE group has an input (RUN) with which
the processing of the assigned function blocks can be started or
stopped. In the stopped state, all outputs assigned to the Twin-
SAFE group are in the safe state. The RUN input must always
be linked to a standard signal for the EL6910 and newer logics.
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2. , Now we start adding function blocks to the network. The available safety function
blocks are located in the toolbox window on the right-hand side of the screen.

) The safety function blocks are available on the TwinSAFE terminal

j EL6910.

[l |

Fig. 113: TwinCAT 3 - Toolbox window

=
O If there are no safety function blocks when you first open the
i toolbox, save and close the project. After reloading the project,
there should be safety function blocks in the toolbox.

[l |
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3. » Click on the desired safety function block and drag it into the network.

Fig. 114: TwinCAT 3 - safeAnd dropped in TwinSafeGroup1
=

=

) There must be at least 1 network with a safety function block so
i that the safety project can be transferred to the controller.

[l |

The safety function block safeAnd was selected here because it can be con-
nected to a non-safe input at the first terminal. Due to the AND link, the safety of
the application is guaranteed, because the second terminal must be connected
to a safe input.
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4. . Click on the green plus sign in the Variables tab of the Variable Mapping window to
create the variable Var_In1. Then click on the green plus sign again and create the
variable Var_In2.

) The Variable Mapping window at the bottom of the screen is not
i displayed automatically. It must be explicitly selected.

[l |

Fig. 115: TwinCAT 3 - Create variables Var_In1 and Var_In2 for safeAnd
5. We now link these two variables to the inputs of the safeAnd.
Click on the Map to button in the Var_In1 row.

Fig. 116: TwinCAT 3 - Open Usage Map to dialog for variable Var _In1
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6. » Inthe Map to dialogue box, select the Andin1 input of the safeAnd and confirm with
OK.

Fig. 117: TwinCAT 3 - Map Usage to Andin1 for variable Var_In1
7. » Inthe Var_In2 row, click on the Map to button under Usage.

Fig. 118: TwinCAT 3 - Open Usage Map to dialog for variable Var _In2
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8. » Inthe Map to dialogue box, select the Andin2 input of the safeAnd and confirm with
OK.

Fig. 119: TwinCAT 3 - Map Usage to AndIn2 for variable Var_In2
= As Usage, the two variables are now linked to the inputs of the safeAnd.

Fig. 120: TwinCAT 3 - Variable Var_In1 and Var_In2 linked to safeAnd
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9. » We now assign the variable Var_In2 to InputChannel1 of the TwinSAFE input ter-
minal EL1904.

In the Var_In2 row, click on the Map to button under Assignment.

Fig. 121: TwinCAT 3 - Open Assignment Map to dialog for variable Var _In2
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10.). In the Map to dialogue box, select the input InputChannel1 of EL1904 and confirm
with OK.

Fig. 122: TwinCAT 3 - Map variable Var_In2 to InputChannel1 of EL1904

= The variable Var_In2 is now assigned to InputChannel1 of the TwinSAFE input
terminal EL1904.

Fig. 123: TwinCAT 3 - Variable Var_In2 assigned to InputChannel1 of EL1904
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) Fields with a yellow background belong to Safe I/O, fields with a
i green background belong to GroupPort and fields with a purple
_ L background belong to FunctionBlock Port.

This colour code is displayed as context-sensitive help when
the mouse pointer is on the Assignment or Usage fields.

Fig. 124: TwinCAT 3 - Color code for variable mapping
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1.

O Only safe inputs can be selected as Assignment via Map to. The
i use of non-safe inputs is only possible via Alias Devices.

[l |

We therefore add an alias for the non-safe input in TwinSafeGroup1 under Alias
Devices.

Fig. 125: TwinCAT 3 - Add Alias Device in TwinSafeGroup1

= In the Add New Item dialogue box, select 1 Digital Input (Standard) and confirm
with Add.

Fig. 126: TwinCAT 3 - Add Digital Input as Alias Device in TwinSafeGroup1
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The digital input is set up as an Alias Device.

Fig. 127: TwinCAT 3 - Digital Input as Alias Device in TwinSafeGroup1 added
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12., Rename the created digital input via Rename in the context menu.

Fig. 128: TwinCAT 3 - Rename added Digital Input in TwinSafeGroup1
= The digital input is renamed Var_from_PLC_ALIAS.

) It is advisable to add the variable name 'Alias’, otherwise it is
i easy to lose track.

[l |

Fig. 129: TwinCAT 3 - Digital Input in TwinSafeGroup1 renamed as
Var from_PLC _ALIAS
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13., We now assign the Alias Device we just created Var_from_PLC_ALIAS Var_In1.

Double-click on Var_from PLC ALIAS.sds in the Solution Explorer to call up the
Alias Device.

In the Var_In1 row, click on the Map fto button under Assignment.

In the Map to dialogue box, select the input In (Channel 1) of Var_from PLC ALIAS
and confirm with OK.

Fig. 130: TwinCAT 3 - Assign Var_In1 to Var_from_PLC_ALIAS

= The created Alias Device Var_from_PLC_ALIAS is assigned to Var_In1. The
white background in the Var_In1 line shows that the Alias Device is of the
Standard I/0 type.

Fig. 131: TwinCAT 3 - Var_from_PLC_ALIAS assigned to Var_In1
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) The Alias Device Var_from_PLC_ALIAS can be linked to a variable
i declared in the PLC node.

=~ We now link Var_from_PLC_ALIAS to an input of the 4-channel digital
input terminal EL 1004, to which a switch is connected.

14., Double-click on Var_from_PLC_ALIAS.sds in the Solution Explorer to call up the
Alias Device.

Fig. 132: TwinCAT 3 - Open Var_from_PLC_ALIAS in Solution Explorer
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15.,. In the main window, click on the link button on the right side of the Linked to: field.

Fig. 133: TwinCAT 3 - Link Button of Var_from_PLC_ALIAS
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16.). Select the input of Term 6 (EL1004) and confirm the dialogue box with OK.

Fig. 134: TwinCAT 3 - Link Var_from_PLC_ALIAS to EL1004

= The Linked to: field shows that the link has been successfully established.

Fig. 135: TwinCAT 3 - Var_from_PLC_ALIAS linked to input of EL1004
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17., The AndOut output of the safety function block safeAnd is now assigned to a virtual
input in the Advanced Safety Module as an activation input.

For this purpose, another variable must be created in the variable mapping of the
safety function block. We give this variable the name Out_to ASM7_Input.

Fig. 136: TwinCAT 3 - Create variable Out_to ASM7_Input in TwinSafeGroup1
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18.) Inthe Out_to ASM7_Input row, click on the Map to button under Assignment.

In the Map to dialogue box, select the AndOut output of FBAnd1 and confirm with
OK.

Fig. 137: TwinCAT 3 - Assign Out _to ASM7_Input to FBAnd1

= The created Alias Device Out_to_ ASM7_Input is assigned to FBAnd1. The
purple background in the line Out_to ASM7_Input shows that the Alias Device
is of type FunctionBlock Port.

Fig. 138: TwinCAT 3 - Out_to ASM7 _Input assigned to FBAnd1
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19.) Inthe Out_to ASM7_Input row, click on the Map to button under Usages.

In the Map to dialogue box, select the input Virtual Input 0 of SGD7S-
xxxDA0OxxxxF91 CoE Drive and confirm with OK.

Fig. 139: TwinCAT 3 - Assign Virtual Input 1 to Advanced Safety Module

= The created Alias Device Out_to ASM7_Input is assigned to Virtual Input 0.
The yellow background in the line Out_to ASM7_Input shows that the Alias
Device is of type Safe I/0.

Fig. 140: TwinCAT 3 - Out_to ASM7 _Input assigned to Advanced Safety Module
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20.,. Click on the Verify Safety Project icon in the TwinCAT Safety toolbar.
= This checks the validity of the safety project.

Fig. 141: TwinCAT 3 - Verify Safety Project

If errors are detected during the check, this is indicated with the dialogue box
There were validation errors, continue save?. In addition, the Error List at the
bottom of the screen, alongside other messages or warnings, indicates which
error was detected.

Fig. 142: TwinCAT 3 - Verify Safety Project - There were validation errors
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If No was clicked in this dialogue box, the following dialogue box appears, indi-
cating that not all files of the safety project could be saved.

Fig. 143: TwinCAT 3 - Verify Safety Project - Could not save all safety project files

When the safety project has been successfully checked for validity, the mes-
sage Verification Process Succeeded is displayed at the bottom left of the
screen.

Fig. 144: TwinCAT 3 - Verify Safety Project - Verification Process Succeeded
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5.3.6 Download the Safety Project

If no errors were detected when checking the safety project for validity (message "Verifi-
cation Process Succeeded"), you can continue with the download of the project.

1. » Inthe TwinCAT Safety toolbar, click on the Multi-Download Safety Project(s) icon.
This allows multiple safety projects to be downloaded to the corresponding logic
components at the same time.

Fig. 145: TwinCAT 3 - Multi-Download Safety Project(s)

2. . Inthe Select Valid Project(s) dialogue box, select the projects for which a simulta-
neous download is to be performed (in the scenario described here, there is only
one project).

Fig. 146: TwinCAT 3 - Select Valid Project(s)
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3. » Inthe General Download Settings dialogue box, the user name and password are
entered first.

The default user is Administrator and the default password is TwinSAFE. The input
is case sensitive.

Fig. 147: TwinCAT 3 - General Download Settings

= In the Verified checkbox, confirm that the correct serial numbers are displayed
and used. Start the download with the Next button.
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4. , Inthe Final Verification dialogue box, confirm the correctness of the checksums
(Online CRC and Calculated CRC) by selecting the checkbox and clicking Next.

Fig. 148: TwinCAT 3 - Final Verification

5. ) Inthe Activation dialogue box, enter the password of the user you are using again
and click Next.

Fig. 149: TwinCAT 3 - Activation
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6. » Inthe Multi-Download Result dialogue box, all projects with the status Activated and
Downloaded are listed. Use the Finish button to finish the download.

Fig. 150: TwinCAT 3 - Multi-Download Result

5.3.7 Activate Configuration and Display Online Data
1. » Activate the downloaded configuration by clicking the Activate Configuration icon.

Fig. 151: TwinCAT 3 - Activate Configuration
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2. , Confirm the activation of the configuration by clicking OK in the Activate Configura-
tion dialogue box.

Fig. 1562: TwinCAT 3 - Confirm Activation
3. » Restart the TwinCAT system in Run Mode by clicking OK.

Fig. 153: TwinCAT 3 - Restart TwinCAT System in Run Mode
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4. , Click on the Show Online Data icon in the TwinCAT Safety toolbar.

Fig. 154: TwinCAT 3 - Show Online Data
= This causes the display to change to the current values within the safety project.

In the following example, the TwinSafeGroup1.sal worksheet is outlined in dark
red. This indicates that the group is in Unknown state.

Fig. 155: TwinCAT 3 - Group is in state Unknown
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In this example, the TwinSafeGroup1.sal worksheet is outlined in green. This
indicates that the group is in Run state.

Fig. 156: TwinCAT 3 - Group is in state RUN
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6 EDM output concept of SGD7S-OSB01A/OSB02A compared to
SGDV-OSA01A

Input behaviour of SGDV-
OSA01A

External Device Monitor
output signals of SGDV-
OSA01A

SRI-Al signal ON | OFF (Safety Function Operation Request)
OFF (Safety Function
SRI-A2 signal ON Operation Request)
tm
t_alm <tm
]

Safety Function A 4(Operating Safe (HWBB) state

td

-—

ALM signal®  OFF ON

Fig. 157: Input behaviour of SGDV-OSAO01A

tm Time period during which time measurement is performed: Measurement is per-
formed until an alarm occurs.

t alm Specified value

td Alarm output delay time (40 ms max.)

The time period tm is the Discrepancy Time and is equal to 10 seconds within the SGDV-
OSAO01A.

O You can set the same time (up to 1000 ms) inside the SGD7S-OSB01A/
i OSBO02A.

1

The following figure shows the parameterisation of the Discrepancy Time in the Advanced
Safety Module Parameter Editor.

Fig. 158: Setting Discrepancy Time in the Advanced Safety Module Parameter Editor

These signals are output when the following two conditions are met:

B The safety function is operating normally.

B No malfunction occurs in the safety function.
If a malfunction occurs in the safety function when the safety function is operating,
this signal will not be output.
By monitoring this signal from an external device, a sequence can be designed for
returning to normal operations from the safety function operation state.
The following figure shows the relationship between the External Device Monitor
Signal and safety function.
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Fig. 159: Relationship between the External Device Monitor Signal and safety function

) Each safe output of the SGD7S-OSB01A/OSB02A can be used as 2

EDM outputs.

1

1

Fig. 160: Output Signal Type and Output Signal Behaviour

Failure of the safety functions can be detected by monitoring the Safety Request Input
Signals and the External Device Monitor Output Signals.

The following table shows the logic for the Safety Request Input Signals and the External

Device Monitor Output Signals.

Signal Name
Safety Request Input Signal A1
Safety Request Input Signal A2

Code
SRI-A1
SRI-A2

External Device Monitor Output Signal A  EDM-A

Logic

ON ON OFF OFF
ON OFF ON OFF
OFF OFF  OFF ON

This logic is the same for the Safety Request Input Signal B.

EDM remains OFF, it takes the specified time until a malfunction can be recognized.

Only when both Inputs (A1, A2) are OFF the External Device Monitor can change to ON
... even if the safety function is already running.
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) In the SGD7S-OSB01A/OSB02A we test the inputs continuously.
i There is no need to use an unsafe External Device Monitor.

OFF (Safety Function

EDM output functions of _
Safety request input state A ON Execution Request)

SGDV-OSA01A

—— Safety function is operating.

State of Safety Function A {
Safe state

Monitoring speed

External Device
OFF ON
Monitor Output Signal A ‘

Fig. 161: Operation Timing When Pc01.0 = 0 (Output Condition = Safety Function Opera-
tion)
This signal behaviour corresponds to EDM = ON (HIGH) during working safety function.

OFF (Safety Function
Safety request input state A ON Execution Request)

Safety function is operating.

Status of Safety Function A {

Safe state
Monitoring speed
External Device
OFF ON
Monitor Output Signal A

Fig. 162: Operation Timing When Pc01.0 = 1 (Output Condition = Safe State)
This signal behaviour corresponds to EDM = ON (HIGH) during safe state.

) SGD7S-OSB01A/OSBO02A has four possible External Device Monitor
i signals:
—— — HIGH during operation
— HIGH during working safety function
— HIGH after limit violation
— HIGH during safe state
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Fig. 163: Output Signal Type and Output Signal Behaviour

Difference of EDM output Activation Input o _
. ON OFF (Activation of a safety function
behaviour (SRI-A1) | ( y )
Activation Input : L .
(SRI-A2) P ON | OFI:? (Activation of a safety function)

Safety Function —(Ope:ratingx Safe (HWBB) state

EDM Signal Output OFF | ON (EDM output ON during operation)

Fig. 164: EDM output behaviour of SGDV-OSAO01A

) The SGDV-OSAO1A can have a delay of the specified time (state does
i not change to ON until both inputs are OFF).

1

Activation Input - .
(channel 1) P ON | OFF (Activation of a safety function)
Activation Input ON S f fety f .
(channel 2) | OFF (Activation of a safety function)

Safety Function —KOperatingX Safe (HWBB) state

EDM Signal Output OFF | ON (EDM output ON during operation)

Fig. 165: EDM output behaviour of SGD7S-OSBO0O1A

) The SGD7S-OSB01A/OSB02A can immediately have the "ON state”
i when the safety function is in operation.

= Another advantage of the SGD7S-OSB01A/OSB02A (compared to com-
petitor products) is that it provides the EDM signal without an additional
relay. A change of an OSSD output (such as is present in safety light cur-
tains) directly changes the state of the EDM output.
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Change EDM State If it is desired that SGD7S-OSAB01A/OSB02A behaves like SGDV-OSAOQ01A, this can be
behavior of SGD7S- achieved as shown in the following figure.
OSB01A/OSB02A to

SGDV-OSA01A SGD7S-0SB02A

Fig. 166: Change behaviour of SGD7S-OSB01A/OSB02A to SGDV-OSA01A
EDM = /A1 & /A2 & EDM_ASM7
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Troubleshooting

7 Error Handling

7.1 Introduction
There are several indicators for the status of security:

B The 2 LEDs on the Advanced Safety Module board
B  The Alarm display of the SERVOPACK

B The FSoE status message

B The monitor function in SigmaWin+

For detailed information on the indicators mentioned, please refer to the Product Manual
of the Advanced Safety Module:

Name Manual number

Advanced Safety Module for Sigma-7 SERVOPACKs SIEP YEUOS7S 01
SGD7S-000ODA0O8OMOF91, 400 V, Product Manual

7.2 Advanced Safety Module LEDs
Refer to chapter 12.5 "Status Display" of the Advanced Safety Module Product Manual.

7.3 SERVOPACK Alarm Display
Refer to chapter 14.3 "List of alarms" of the Advanced Safety Module Product Manual.

7.4 FSoE Status

Refer to the chapters A.3.2.2 "Rx Process Data" and A.3.2.2.1 "Detailed Parameter
Description of Rx Process Data" in the Appendix of the Advanced Safety Module Product
Manual.

7.5 SigmaWin+ Monitoring

Refer to chapter A.4 "Monitoring Parameters" in the Appendix of the Advanced Safety
Module Product Manual.

7.6 Troubleshooting

Refer to chapter 14.4 "Troubleshooting of alarms" of the Advanced Safety Module
Product Manual.
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8 Revision History

The revision dates and numbers of the revised manuals are given on the bottom of the

back cover.

MANUAL NO. SIEP YEUOST7S 02A

—[ 1
Published in Germany ~ March 2022 22-03 <>
L 2 L 3 —[4

1 Manual version
2 Date of publication
3 Date of original publication
4 Revision number

Date of publication Manual Rev. Section Revised content
version no.

March 2022 A 0 - First edition
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